
Crash Intro to SIS  1 

A CRASH INTRODUCTION TO IUCN’S 
SPECIES INFORMATION SERVICE (SIS) SYSTEM 

 
Version 1.0 

February 2009 
 
 
Table of contents 
               Page 
What is SIS? ................................................................................................................................... 1 
Browser requirements .................................................................................................................... 2 
The SIS Interface ........................................................................................................................... 2 
Editing data on taxa that are already in SIS ................................................................................ 4 
How to create a New Assessment .................................................................................................. 8 
Creating a new Working Dataset................................................................................................. 11 
Adding a new taxon to SIS .......................................................................................................... 15 
Editing newly entered taxa .......................................................................................................... 18 
Generating reports ....................................................................................................................... 19 
Current SIS issues being addressed ............................................................................................ 20 
 

 
 
What is SIS? 
 
In its broadest sense, IUCN’s Species Information Service (SIS) is an informatics tool that 
allows authorized users to update and make changes to the information contained in the IUCN 
species database. This database is at the core of the IUCN Red List of Threatened Species, from 
which all published species assessments originate. SIS is also a relational system, where all 
information is linked to species assessments, both historical and current ones. 
  
SIS is designed to work both online and offline, the latter option providing users with the 
capacity to work on species assessments in instances where internet connections may not readily 
be available or stable. However, some things are best done online rather than offline. For 
example, it is possible to add new species to SIS both online and offline, but species deletions 
should be done online. 
 
SIS can be used for both Global and Regional Assessments; however, note that SIS does not 
have the ability of merging Regional Assessments. 
 

Please note that this is a working document subject to changes and additions; all future 
versions will be given a new version number. 
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Browser requirements 
 
SIS runs on any of these browsers: 
 

 Apple Safari 
 Firefox 3 
 Google Chrome 

 
Internet Explorer does not use the same standards as the browsers listed above, so this browser 
should not be used. 
 
For any of the three browsers listed above, do not use the toolbar buttons, such as the back and 
forth arrows – press F11 to remove these buttons, this will take SIS into a full-screen mode. 
 
If using Firefox, a useful add-on that can be downloaded is ABCtajpu 
(https://addons.mozilla.org/en-US/firefox/addon/459). This add-on allows for the addition of 
diacritics within SIS/Firefox. Once installed, go to Tools>Options in the Firefox toolbar to 
access a pop-up keyboard with special symbols. Other useful Firefox add-ons include 
dictionaries in different languages (see https://addons.mozilla.org/en-US/firefox/browse/type:3). 
 
The login pages for both the SIS test site and the actual SIS site can be found at: 
 
http://sistest.iucnsis.org/SIS/index.html 
http://sis.iucnsis.org/SIS/index.html 
 
Changes in the SIS test site will be saved but will not affect the information currently on SIS; 
however, any change effected in the SIS site will be saved and will affect assessments appearing 
on the next update of the Red List web site and whatever analyses are conducted thereafter. 
Therefore, if there is anything you are unsure about when working in SIS, it is very 
important to try the actions you want to do on the test site first. Then if any unexpected 
outcomes occur, you will not have changed anything on the live site. 
 
The SIS Interface 
 
To log into SIS, each user needs to be assigned a username and a password. Currently, this is 
done by contacting Jim Ragle at IUCN HQ (email: james.ragle@iucn.org). When logging in 
(your username is likely to be your email account, the default password provided is “changeme”- 
you can later change your password to another one of your choice), the SIS Toolkit will be 
uploaded and you will be shown a default page that looks something like this: 
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The main SIS page is divided into five parts: 
 

1. The Navigation toolbar (top, monkey face icon next to the frog on the mouse) 
2. The “Search” toolbar, to the right of the Navigation toolbar, which has several tools in 

addition to searches 
3. Working Sets and Saved Assessments panes, on the left side of the page 
4. Recent Assessments pane, at the centre of the page 
5. Inbox and Assessments to review, on the right side of the page 

 
The Navigation toolbar shows what species/working set is selected, and the left and right green 
arrows allow us to navigate through the taxa in a working set. 
 
The “Search” toolbar allows users to do a number of things: browse through a taxonomic 
hierarchy, search a taxon by scientific or common name, and a number of other functions (e.g. 
Import/Export, Trash, Batch change) that are currently restricted to administrative users. 
 
Note: when searching for a taxon by common name, please note that common names are set as 
plural and that the search will find every instance where some part of the name is used, even if it 
is not in the same taxonomic group. 
 
The My Working Sets pane lists the existing working sets that a user has set up and saved. 
Clicking on the curvy green arrow next to a working set will take the user to the Summary tab of 
the selected Working Set Page, which displays administrative information (e.g. name, manager, 
date created, etc.) on the working set and taxonomic information on its component taxa/species. 
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The Recent Assessments pane lists the last ten species that have been worked on, including their 
assessment status (Published or Draft) and their nature (Global or Regional). 
 
Inbox and Assessments to review are functionalities that can be used between users that are 
working on given subsets of a database (i.e. Working sets) and assessors. 
  
Editing data on taxa that are already in SIS 
 
If we wish to quickly find a particular taxon, we click on the magnifying glass icon in the Search 
toolbar (top right corner of the screen, circled below):  
 

 
 
This will open up a Taxonomy search window. Type the name of the species that we are looking 
for, e.g.  the toad Duttaphrynus microtympanum, and click on the search button. This will return 
a list of matching names found in the system, taxonomic hierarchy up to family level and the 
current threat category for each taxon in the list:  
 

 
 
Another way of finding a taxon is to use the Peruse the Taxonomic Hierarchy button to the left of 
the magnifying glass icon; this button allows us to browse the hierarchical level down to the 
taxon of interest. Once there, we click on the View button and then on the Taxon Home Page tab. 
 
If we click on the species name, it will take us to the Taxon Home Page, indicated by the 
highlighted Taxon Home Page tab (see image below). On the left pane we will find the species 
name in red lettering and below its associated General Information, while on the right pane we 
will find the species’ current threat category in red lettering and below we will find a list of the 
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assessments available for this species by date, including a summary of the threat category and 
criteria and its status in each assessment. If an assessment’s Status reads as being Published, it 
means that it has already been published on the Red List. If it figures as Draft, it is still being 
worked on.  
 
SIS contains the entire history of a species’ assessments, and each assessment contains all of the 
information included for a species at the time of that respective assessment. 
 

 
 

 
 
In the General Information pane in the left, there is a hyperlinked number next to the Taxon ID 
field. Clicking on this number will link to this particular species’ account in the Red List page. 
Under the Parent field, in the same area, there is a squares and line icon – clicking on this icon 
will open a pop-up window with the taxonomical hierarchy for the species in question.  
 
If we click on the  Edit/View icon (or on the Assessment Data Browser tab, if it has already 
been opened), it will take us to the Assessment Data Browser window (tab highlighted). Under 
this tab, the left pane displays the different View options available for viewing the assessment 
data (i.e. All Fields View, Factor View, Criteria Factor View, Narrative View; these are 
customizable according to user preferences), as shown below: 
 

Warning: Any changes done to a Published assessment will directly affect the content of 
the assessment that is on the Red List when it is next updated. 
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Clicking on any of these Views will provide details of the different sections available under 
them. So, if we click on e.g. Habitats and Ecology under All Fields View, SIS will display this 
section’s information on the centre-right side of the web page, and the specific tabs 
(components) associated to this section (below). Note that Habitats and Ecology is bolded in the 
Fields pane so that we can quickly identify where we are located within the assessment. 
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All tabs have a handful of icons that can be used to facilitate editing of fields: 
 

= Deletes data 
= Adds a reference (changes colour to blue when a reference has been added and saved) 
= Adds notes (changes colour to yellow when text has been added and saved) 
= Definable terms 

There is also a clipboard icon that allows us to copy and paste text from one field to another 
(sorry, couldn’t copy that icon!) 
 

= Information 
 
Beneath the icon toolbar we will find several toggle buttons that allow us to change different 
features in the narrative/text fields; these work in much the same way as they would in a word 
processing application. Thus, B = Bolds text, I = Italicizes text, U = Underlines text, X2 = 
Subscripts text, X2 = Superscripts text, and so on. The Tx function removes the formatting from 
text (e.g. Word-formatted text as .rtf, instead of .xhtml). It is also possible to change the 
background colour of entered text, essentially allowing users to highlight text that they may want 
to revisit or follow-up on, for example. 

 
Every time we click on a different section of the View we are using we will get a pop-up window 
with the following message:  
 
Navigating away from this page will revert unsaved changes. Would you like to save? 
 
 

 Yes    No   

Bibliography 
The Bibliography is not present as a stand-alone section in the different Views – this is 
because the Bibliography is now integrated into the different sections, so that we can associate 
a specific reference to a specific section.  If we click on the icon in any section of an 
assessment, it will open up a new window and will give us the option to either search the 
existing reference database or add a reference to the Bibliography [under the Reference 
Search tab, Enter New Reference button]. If searching, we should enter the author(s) name(s), 
year and/or title or if adding a new reference we should click on the Enter New Reference 
button. Note that when we add a new reference and it has been accepted, we will need to run a 
search for the newly added reference so that it figures in the resulting hits. We select (by 
clicking once) the reference of interest and then click on the Attach Selected button, which 
will proceed to include it in the Bibliography tab for that particular section. We can either 
click on the Bibliography tab or close the window and check that the icon colour has changed 
to blue ( ) to ensure that the reference has been added. 
 
In order to access Bibliography in SIS, click on the Tools button and select Manage 
References while editing or viewing a species’ assessment. 
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This allows us to save any changes we may have made to the specific section we have been 
working on. 
 
How to create a New Assessment 
 
Let us suppose that we have new information for a species that is already in the database and that 
we know that this information will have a bearing on its threat status, such as population status 
information, geographic distribution and/or threats. In order to create a new assessment or 
reassessment, we first need to find the species in question, either through browsing the database 
through the Peruse the Taxonomic Hierarchy button or through the Search button of the “Search” 
toolbar, and then clicking on the Taxon Home Page tab (see Editing data on taxa that are 
already in SIS). The Kihansi Spray Toad Nectophrynoides asperginis is used here as an example: 
 

 
 
The Assessment List pane lists those assessments that are available for the species – in this case, 
one assessment, published in 2004. If we now click on the Assessment Tools button it will 
prompt a one-option menu that reads Assess Current Taxon. Clicking on this option will prompt 
another window to open (New “Genus species” Assessment), which will look something like 
this: 
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The Assessment Type field asks whether we want to use a draft or user assessment. We select 
Draft. The From field asks whether we want to use a pre-existing published assessment to 
populate our sections or whether we want our sections to be blank. To save time, we may want to 
choose a pre-existing published assessment – in this case, it would be the 2004 assessment. We 
then click on the Create Assessment button. A message will then appear saying that “An 
assessment for xxxx (in this case, Nectophrynoides asperginis) has been created”. The 
Assessment List pane will not show the new assessment added unless we leave that tab and then 
return to it. So we can click on any other tab and then click again on the Taxon Home Page tab. 
This time it should show the newly added draft assessment, which will have the date of the 
assessment that we used to populate the different sections: 
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Suppose that we created a blank draft assessment and then figured that it was better to create one 
from a previous assessment. We can just click on the Trash  button for that draft assessment. A 
pop-up window will ask whether we are sure that we want to delete this assessment. If we click 
on Yes, SIS will then discard this assessment, and we can repeat the procedure to create a new 
assessment according to our preferences. 
 
Another way to create new assessments is by clicking on the   Edit/View icon of the most 
recent assessment or the assessment that we want to use. We can click on the New button and 
select assessment type (i.e. draft) and in the From field we can select either the published 
assessment that we want to use as a template or a blank assessment. 
 
Once we have created our new assessment and are in the Assessment Data Browser tab, notice 
that there are six buttons (Edit Data Mode, New, Save, Attach File, Summary and Tools) in the 
top row of that tab: 
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The Edit Data Mode can be changed to Read Only mode with one click of the mouse, so be sure 
that the button is set to Edit Data Mode when changing any specific section of an assessment. 
The New button prompts the creation of a new assessment; the Save button has to be clicked 
every time we have made changes that we want to keep in a section and the Attach File uploads 
any specific file that we consider is relevant to the section in question. The Summary button 
contains a feature called the Quick Criteria Generator Result, which in essence calculates the 
best possible threat status for the species in question given the information that is populated into 
the different fields. It is, however, also possible to change this to manual under the Red List 
Assessment section, Red List Status tab (Enter Manual Data/Revert to Calculated button). 
The Tools button has a drop-down menu that allows users to do edit common names, synonyms, 
attach images, manage references, view notes, track changes, see comments and view reports. 
 
Notice that each section on the left under a given View option (i.e. Distribution, Occurrence, 
Population, etc.) has several tabs with different kinds of information. It will not be possible to 
populate all of these tabs for most taxa, but it is important that the narrative/text fields are as 
clear and as detailed as possible (especially with regards to threats), as these are the main source 
from which different fields and classification schemes are developed for each taxon. 
 
Creating a new Working Dataset 
 
Working datasets are a convenient way to group and manage different sets of taxa. This 
functionality allows us to group taxa by different parameters, such as taxonomic groups, 
assessment date, region/country, etc. The Working Set Manager (under the Working Set Page 
tab) enables us to create, edit (including adding or removing taxa from a dataset), import and 
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export (both for offline use and for querying subsets with Microsoft Access) datasets as well as 
generate reports (species accounts) for species in these datasets. All Working set functions can 
be found in the Working Set Page tab. 
 
Let us suppose that we want to keep track of all of our new edits in SIS, or that we want to 
cluster all species of a given region together for a workshop or follow-up with experts. Click on 
the Working Set Page tab. The centre-right pane displays two tabs, Summary and Working Set 
Manager. Click on Working Set Manager. This tab displays a number of buttons, all of which are 
applicable directly to working sets. Since we don’t have a working set yet, we’ll click on the first 
button: New Working Set, which will create a new set for us. The screen that follows should 
look something like the one below: 
 

 
 
We can pick a name for the Working Set, e.g. New 2009 edits in SIS. For Working Set Type, we 
can choose between private and public (Jim recommends private to make it safer), and for a 
Description we can write anything that helps identify the Working Set (we have to write 
something in this field, otherwise we can’t save the Working Set!). We then click on the Save 
and Add Taxa button. Under the Working Set Navigation pane we should now see the name of 
our new Working Set – in our case, New 2009 edits in SIS. Our Working Set is now created, but 
we still need to populate it. If we go back to the Working Set Manager tab and click on the Taxa 
Manager button, we should see something similar to the following window: 
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Using the pane on the right hand side, we can browse down to the hierarchical level of interest 
(in our case, the species level). We can select one or more species by ticking the appropriate 
boxes, and once done, click on the Add button. A pop-up message reading “Taxon successfully 
added to working set New 2009 edits in SIS” should appear. The species added should then 
appear on the central pane. If only a list of number of species by a higher hierarchical level is 
shown (such as e.g. Anura – 12 species), click on the Species button at the end of the taxonomic 
buttons – this should list every species that has been added to the Working Set. 
 
Now some (or most of these species, if this is the first time that we’ll will be dealing with them 
this assessment year) species will likely need new draft assessments. Click on the Working Set 
Manager tab and then click on the Assessment Manager button. This will take us to a new 
window that allows us to add draft assessments to either the entire Working Set or to selected 
taxa. Once we select the taxa that we want to add draft assessments to and click on the Create 
Assessments button, we will have a Working Set of taxa with draft assessments that are ready to 
be edited and that may look similar to this: 
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Note that the draft assessment data (or lack of) is displayed for the species that is highlighted in 
blue. We can scroll down the list and the assessment data will change according to the 
highlighted species. Note, too, that if the Working Set contains any species that we may have 
recently worked on (such as after the Red List going online last year), SIS will use the 
assessment done back then as the default draft assessment. A species can only have one draft 
global assessment and one draft regional (per region) assessment at a time.   
 
To start working on any given species within our Working Set, we highlight the species we want 
to begin with, and click on the View/green arrow button above the list. This will take us directly 
into the Taxon Home Page for that particular species. The image below displays the Taxon 
Home Page for the selected species, toad Rhinella quechua: 
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If we now click on the   Edit/View icon in our draft assessment, it will take us to the 
Assessment Data Browser page for R. quechua. Note that all of the sections in the species 
account are empty – some sections will need to be populated from previous assessments 
available for the species. 
 
Adding a new taxon to SIS 
 
Suppose there is a newly described species that we would like to add to SIS. We click on the 
main SIS Home Page tab, and then click on the Peruse the Taxonomic Hierarchy icon on the 
Search toolbar. A pop-up Taxonomy Browser window will appear, allowing us to navigate 
through the taxonomic hierarchy.  
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We navigate down to genus level, and then click on the “View” button. We then close the pop-up 
window and click on the Taxon Home Page tab. This tab will now display information for the 
genus that we have selected, including a list of existing species under this genus in the right hand 
pane. The image below shows results for the toadlet genus Brachycephalus, which contains 11 
species (the bottom of the species list pane displays both the page number and the number of 
taxa displayed in that page): 
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We then click on the Taxomatic tools button and select Attach New from the drop-down menu. 
A pop-up window appears prompting us to include the new species name, the authority who 
described it and the species status.  
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Once we fill in the three fields (when filling in the species name we just include the specific 
epithet without the genus name) and click on Save and Close, the species will be added to the 
species list for that genus. A pop-up window will also ask us if we wish to add this taxon to an 
existing dataset, which we may or may not want to do. Let us suppose, however, that we want to 
keep all of our new edits and additions in a single working dataset. If we click Yes, a new pop-up 
window that reads “Choose the working set you would like to add (species name) to”, and will 
list our existing working sets, if we have any. We then select the working set that we want the 
species added to and click Add to selected. A new pop-up window will appear indicating that we 
have been successful in adding the new species to our working dataset, and the species will now 
figure on the list of species detailed in the Taxon Home Page and in the total number of taxa 
displayed. Our newly added species name will sport an asterisk next to it – this indicates that the 
species is a new addition to the database. If we click on the species’ name, it will take us to the 
species’ Taxon Home Page, which will be empty except for the information we entered in the 
pop-up window. There is also a Status field (under the General Information pane on the left hand 
side), which should read N for new taxon (this is automatically done by SIS). Here’s an example 
with the fictitious test toadlet, Brachycephalus testi: 
 
 

  
 
Editing newly entered taxa 
 
To create and edit a new assessment for the newly added Brachycephalus testi, we follow the 
same procedure as when we add and edit a new assessment for a species that is already in the 
database (see sections Editing data on taxa that are already in SIS and How to create a New 
Assessment). Given that this is a new species for which there is no pre-existing information, the 
assessment will likely be blank and it will be a draft Global assessment. 
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Once we create a new assessment for Brachycephalus testi, if we then click on the Assessment 
Data Browser tab and choose our preferred View (e.g. All Fields View), we will be able to 
populate the different fields for each section:  
 

 
 
It is important to remember to click on the Save button every time we finish a section, so that 
work is saved as we develop a particular assessment. 
 
Generating reports 
 
SIS has a built-in functionality that allows users to view reports of specific assessments and to 
save them so that they can be sent to assessors. Under the Assessment Data Browser tab, we 
click on Tools and then click on View Report from the drop-down menu. This will open a new 
tab in the browser with assessment details and the species account. The following example 
illustrates the top section of a report view for the frog Holoaden pholeter: 
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In order to save this report, we can a) save the page as an html document using our browser’s 
interface (i.e. via File>Save Page As), or we can b) save it as a pdf document if we have Adobe 
Acrobat, again using our browser’s interface (via File>Print). 
 
Note that the report is all-inclusive and automatically includes tabs and fields from the All Fields 
View.   
 
Current SIS issues being addressed 
 
Streamlining SIS is still work in progress, and as such, there are still several issues that are in the 
process of being addressed. Some of these are as follows: 
 

 When trying to save whatever new text you added in a given assessment, you may get a 
message that reads “Save not needed - No changes were made”. 

 
 When adding a reference for a particular section of a species account, a pop-up window 

appears to confirm that it has been added, but the options are Close and Ok – and nothing 
happens when we press Ok, so only need to click on Close. 

 
 When trying to edit a reference: When clicking on Edit/View Selected Reference an Edit 

Reference window appears. However, when trying to Save and Close the window the 
following message appears: Update citation The citation does not accurately reflect all of 
the entered information. Would you like to update the citation before saving? The new 
citation would be: (Details of specific citation are provided).  
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 There are three buttons at the bottom of the page (Yes, No and Cancel), but the changes 

do not appear to be encompassed regardless of which button is chosen and the appearance 
of the ensuing message Successfully committed reference changes. The edit function 
does not appear to be doing anything, but what is happening is that it is creating a new 
reference with the changes without overwriting or deleting the previous reference, which 
is most likely tied to an assessment. There is currently no way to remove a reference from 
the reference library if tied to an assessment. 

 
 First author surnames that have an umlaut somewhere may be entered in the bibliography 

but the search function does not appear to find them to tie them to specific assessments. 
 

 The creation of draft assessments for species in Working Sets (i.e. batching draft 
assessments) does not provide us with the option of choosing between a blank assessment 
or using a pre-existing one to populate the different assessment sections. So if a user 
wants to use a pre-existing assessment to populate a draft one, it is best to add each 
species to a working set separately. 

 
 Biogeographic realm and Seasonality appear not to have been uploaded. 

 
 In Ecosystems services, every time we tick insufficient information available we get the 

following message: All coded services should have an importance score of 5 - Not 
Known.  

 
 The report option has some missing information, i.e. absence of bibliography. 


